After the Plan: Using Templates and Scripts to Improve Documentation

Grayden MacLennan
MBA, MSM, MS, CMD
Disclosures

• Grayden worked for MIM Software from 2007-2013, but no longer has financial ties to the company.

• This presentation contains screenshots from several commercial software packages:
  – MIM (MIM Software)
  – RayStation (RaySearch Laboratories)
  – XiO (Elekta)
  – Mosaiq (Elekta)

MacLennan 2017
My Background

• Several careers before Medical Dosimetry
  – Information technology
  – Laboratory science
  – Information technology again
  – Medical imaging technical sales

• I’m a tech geek, but NOT a natural born programmer
What are Scripts and Templates?
What are templates and scripts?

• Templates
  – Document skeletons that use **placeholders** to show where specific content should be inserted

• Scripts
  – Sets of instructions that define a **sequence of actions** that should be performed the same way every time
Dear [name],

We have received your donation of [amount] on [date] and we would like to thank you for your support of our organization.

Sincerely,

[signature_Image]
Example of a template

Dear Grayden,

We have received your donation of $50 on June 15, 2017 and we would like to thank you for your support of our organization.

Sincerely,

[Signature]

MacLennan 2017
Example of a script

Buy a gallon of milk,
and **if there are eggs**, buy a dozen.

MacLennan 2017
The Importance of Standards
Name standardization

• Computers follow instructions exactly
  – If you give them **bad instructions**, you get **bad results**
Name standardization

• Name accuracy matters

• Left Eye can be:
  – Left Eye
  – left eye
  – Eye_Lt
  – eye_L
  – Lt Orbit
  – Etc.
Achieving a little name flexibility

- Templates work by inserting data with known names.
- Some flexibility can be achieved with wildcards.
  - A wildcard character is a stand-in for any number of additional characters.
  - Doesn’t work on every system.

- "PTV*" matches
  - PTV
  - PTV1
  - PTV_5040
SPTC name standardization

- The Seattle Proton Therapy Center has adopted a naming scheme based primarily on the scheme proposed by Santanam et al.
Standardize everything if you can

- Not just contour names
- Clinical goals for each treatment site
- Beam naming
- Plan naming
- Departmental pizza order toppings

MacLennan 2017
Automatic Document Generation in Mosaiq
Plan cover sheet

We’re putting the cover sheet on all the TPS reports now
Plan cover sheet

- **Quick reference**
  - Patient name
  - Treatment room
  - Daily beam summary

- Great for plans with multiple beamsets or rotating fields
Post-plan checklist

- Final check that Dosimetry’s work is done
- Must be filled out and approved by Dosimetrist before treating
Proton Beam Dosimetric Summary

**Patient:** Dumbledore, Albus  
**Patient DOB:** 6/30/1881  
**Attending Physician:** Pomfrey, Poppy  
**Date:** 6/15/2017  
**PC MR #:** U123456

Computerized Tomography images were obtained for Dumbledore, Albus and were imported into the treatment planning system. Along with the physician, the dosimetrist/physicist identified tumor volume along with nearby normal structures considered to be at risk. The volumes were contoured and the optimal plan using the physician’s identified goals was attained.

**Special Teletherapy Proton Plan Summary**
A special teletherapy proton plan was performed to optimize the proton particle dose distribution to the treatment volume. The plan encompasses the use of custom beam modifiers used to shape the dose distribution. Each treatment field was developed using physician directives and established guidelines to ensure the distribution accounts for beam setup and anatomy uncertainty. Evaluation of the doses from the proton beam plan were performed, including...
Information is already in Mosaiq

• Typing it manually has problems
  – Wasted time and double work
  – Could make typos

• We just need a way to retrieve the data

• Start by converting our document into a template
Converting our doc to a template

- File > Save As
- Choose “Word Macro-Enabled Template (*.dotm)”
- Copy it to the Mosaiq eSCRIBE templates folder
Open the template from Mosaiq

- Right click on the Documents window in Mosaiq
  - Choose “Edit Template”
Mosaiq has added a menu with special features for data linking.
The “Add-Ins” tab

- The “Merge” button will open a window full of data elements.
Patient: Dumbledore, Albus
Patient DOB: 6/30/1881
Attending Physician: Pomfrey, Poppy

Computerized Tomography images were obtained for Dumbledore, Albus and were imported into the treatment planning system. Along with the physician, the dosimetrist/physicist identified tumor volume along with nearby normal structures considered to be at risk. The volumes were contoured and the optimal plan using the physician’s identified goals was attained.
Computerized Tomography images were obtained for {Patient.NameLFM@M} and were imported into the treatment planning system. Along with the physician, the dosimetrist/physicist identified tumor volume along with nearby normal structures considered to be at risk. The volumes were contoured and the optimal plan using the physician’s identified goals was attained.
Adding manual form elements

Plan Name: **Type Here**
Dosimetrist: **Choose Name**

Proton Beam Dosimetric Summary

Special Teletherapy Proton Plan Summary

Initial Rx Dose (CGE): | Boost Rx Dose (CGE): | Total Rx Dose (CGE):
---|---|---

Room | Fields per session | Proton Beam Arrangement | Dose per Fx (CGE) | # of Fx’s | Dose (CGE) | Frequency
---|---|---|---|---|---|---

MacLennan 2017
Adding the Developer tab

- In Word, go to File > Options
Check boxes, menus, and more

- Developer tab has several useful tools
  - Text entry fields
  - Check boxes
  - Drop down lists
Form looks great – now what?

- Once all data links and form elements are added, save your work!

- Switch back to “Add-Ins” tab and click “OK”
Can we autogenerate the docs?

• We have nice templates, but you have to remember to actually use them

• How about a script that fills out a template?

• We’ll use Mosaiq IQ Scripts to autogenerate our two documents during plan export
Trigger-based actions in Mosaiq

• IQ Scripts can be used to perform actions when trigger events happen

• Need a trigger that happens during plan export
  – CPT charge code capture?

• For SPTC, capture of 77321 is a good trigger
  – Spec Therapy Pln Tec
Let’s set up an IQ Script

- File > System Utilities > IQ Engine Configuration
Creating Charge Scripts

移交照片

MacLennan 2017
Cover sheet setup

<table>
<thead>
<tr>
<th>Encounter Parameters</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Type</strong></td>
<td>pPHYS Spec Dosimetry</td>
</tr>
<tr>
<td><strong>Dictated By</strong></td>
<td>Attending Staff</td>
</tr>
<tr>
<td><strong>Review Required</strong></td>
<td>Attending Staff</td>
</tr>
<tr>
<td><strong>Co-Sign Required</strong></td>
<td>(Not Set)</td>
</tr>
<tr>
<td><strong>Transcribed By</strong></td>
<td>Active User</td>
</tr>
<tr>
<td><strong>Encounter Date</strong></td>
<td>Today</td>
</tr>
<tr>
<td><strong>Transcribed Date</strong></td>
<td>Today</td>
</tr>
<tr>
<td><strong>Department</strong></td>
<td>(All)</td>
</tr>
<tr>
<td><strong>Account #</strong></td>
<td>Blank</td>
</tr>
<tr>
<td><strong>eSCRIBE Template</strong></td>
<td>WKGroupIPC - DosimetryIPC - DOS Proton Beam Dosimetric Summary.dotm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applicability</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Which Diagnosis</strong></td>
<td>All</td>
</tr>
<tr>
<td><strong>Diagnosis Code</strong></td>
<td>(All)</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Spec Therapy Pbn Tec</td>
</tr>
<tr>
<td><strong>Users</strong></td>
<td>(All)</td>
</tr>
<tr>
<td><strong>Patients</strong></td>
<td>(All)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Behavior</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create Document if Duplicate Exi...</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Open Document After Creation</strong></td>
<td>No</td>
</tr>
<tr>
<td><strong>Document Status</strong></td>
<td>Pending</td>
</tr>
</tbody>
</table>
Checklist setup

<table>
<thead>
<tr>
<th>Encounter Parameters</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Type</td>
<td>pDosiChecklist</td>
</tr>
<tr>
<td>Dictated By</td>
<td>Active User</td>
</tr>
<tr>
<td>Review Required</td>
<td>(Not Set)</td>
</tr>
<tr>
<td>Co-Sign Required</td>
<td>(Not Set)</td>
</tr>
<tr>
<td>Transcribed By</td>
<td>Active User</td>
</tr>
<tr>
<td>Encounter Date</td>
<td>Today</td>
</tr>
<tr>
<td>Transcribed Date</td>
<td>Today</td>
</tr>
<tr>
<td>Department</td>
<td>(All)</td>
</tr>
<tr>
<td>Account #</td>
<td>Blank</td>
</tr>
<tr>
<td>eSCRIBE Template</td>
<td>WKGroupIPC - Dosimetry/Dosimetry Check List.dotm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Applicability</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which Diagnosis</td>
<td>All</td>
</tr>
<tr>
<td>Diagnosis Code</td>
<td>(All)</td>
</tr>
<tr>
<td>Code</td>
<td>Spec Therapy Pin Tec</td>
</tr>
<tr>
<td>Users</td>
<td>(All)</td>
</tr>
<tr>
<td>Patients</td>
<td>(All)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Document if Duplicate Exit Code</td>
<td>No</td>
</tr>
<tr>
<td>Open Document After Creation</td>
<td>No</td>
</tr>
<tr>
<td>Document Status</td>
<td>Pending</td>
</tr>
</tbody>
</table>
Seeing it in action

- In the **Multi-Code Capture** window...
Documents are now ready
Clinical Goals Scorecard
Planning with clinical goals

• Plans are built around clinical goals
  – Minimum acceptable **target** dose coverage
  – Maximum acceptable **organ at risk** dose coverage

• Examples
  – CTV V100 = 100%
  – PTV V100 = 95%
  – Lacrimal Gland mean dose < 26 Gy
  – Spinal Cord max dose < 45 Gy
Clinical workflow

- Set up a plan
- Calculate/optimize it
- Check DVH values to see if clinical goals are met
- Check and record pass/fail status of each goal
- Do it all again if necessary
Documenting DVH results

• Options for documenting pass/fail of clinical goals
  – Manual DVH tracing, results entered in Excel
  – External plan analysis tool
  – Built in scorecard tools

• Most systems have scorecard features now

• You still need to get the scorecard into a document
RayStation clinical goals table

- Take a screen shot then copy/paste into a PDF
- Also available in Report Designer

<table>
<thead>
<tr>
<th>Priority</th>
<th>Dose</th>
<th>ROI/POI</th>
<th>Clinical goal</th>
<th>Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan dose: Prostate79</td>
<td>Bladder</td>
<td>At most 8.0 cm³ volume at 8000 cGy dose</td>
<td>10.6 cm³</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>Bladder</td>
<td>At most 10.00 % volume at 7000 cGy dose</td>
<td>4.93 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>Bladder</td>
<td>At most 35.00 % volume at 5000 cGy dose</td>
<td>7.81 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>BladderWall</td>
<td>At most 15.00 % volume at 8000 cGy dose</td>
<td>6.96 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>BladderWall</td>
<td>At most 25.00 % volume at 7500 cGy dose</td>
<td>10.87 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>BladderWall</td>
<td>At most 35.00 % volume at 7000 cGy dose</td>
<td>12.12 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>BladderWall</td>
<td>At most 47.00 % volume at 5300 cGy dose</td>
<td>14.63 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>BladderWall</td>
<td>At most 50.00 % volume at 5500 cGy dose</td>
<td>14.32 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>CTV</td>
<td>At least 100.00 % volume at 7920 cGy dose</td>
<td>100.00 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>FemoralHead_L</td>
<td>At most 1.0 cm³ volume at 4500 cGy dose</td>
<td>0.0 cm³</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>FemoralHead_R</td>
<td>At most 1.0 cm³ volume at 4500 cGy dose</td>
<td>0.0 cm³</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>PenileBulb</td>
<td>At most 5250 cGy average dose</td>
<td>4175 cGy</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>PTV</td>
<td>At least 95.00 % volume at 7920 cGy dose</td>
<td>96.72 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>PTVVal</td>
<td>At least 95.00 % volume at 7920 cGy dose</td>
<td>96.06 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>PTVVal</td>
<td>At least 7524 cGy dose at 100.00 % volume</td>
<td>7259 cGy</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalEval</td>
<td>At most 1.0 cm³ volume at 8100 cGy dose</td>
<td>0.0 cm³</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalEval</td>
<td>At most 15.00 % volume at 7500 cGy dose</td>
<td>5.01 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalEval</td>
<td>At most 25.00 % volume at 7000 cGy dose</td>
<td>11.27 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalEval</td>
<td>At most 35.00 % volume at 6500 cGy dose</td>
<td>17.51 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalEval</td>
<td>At most 50.00 % volume at 5000 cGy dose</td>
<td>31.48 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalWallVal</td>
<td>At most 1.0 cm³ volume at 8100 cGy dose</td>
<td>0.0 cm³</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalWallVal</td>
<td>At most 15.00 % volume at 7500 cGy dose</td>
<td>10.90 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalWallVal</td>
<td>At most 25.00 % volume at 7000 cGy dose</td>
<td>20.33 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalWallVal</td>
<td>At most 35.00 % volume at 6500 cGy dose</td>
<td>27.12 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>RectalWallVal</td>
<td>At most 50.00 % volume at 5000 cGy dose</td>
<td>37.95 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>Rectum</td>
<td>At most 1.0 cm³ volume at 8100 cGy dose</td>
<td>0.0 cm³</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>Rectum</td>
<td>At most 10.00 % volume at 7000 cGy dose</td>
<td>10.38 %</td>
<td>![ ]</td>
<td></td>
</tr>
<tr>
<td>Plan dose: Prostate79</td>
<td>Rectum</td>
<td>At most 35.00 % volume at 5000 cGy dose</td>
<td>29.00 %</td>
<td>![ ]</td>
<td></td>
</tr>
</tbody>
</table>

MacLennan 2017
## XiO clinical goals table

<table>
<thead>
<tr>
<th>Structure</th>
<th>Volume (cc)</th>
<th>Min Dose /cGy</th>
<th>Goal Dose (cGy)</th>
<th>Actual Dose</th>
<th>%Inclusion</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTV_R frontal</td>
<td>128.45</td>
<td>5387.0</td>
<td>5400.0</td>
<td>99.90% / 172.28cc</td>
<td>100.0</td>
</tr>
<tr>
<td>PTV_R frontal</td>
<td>239.0</td>
<td>5223.7</td>
<td>5400.0</td>
<td>99.89% / 237.83cc</td>
<td>100.0</td>
</tr>
<tr>
<td>BrainStem</td>
<td>26.47</td>
<td>0.0</td>
<td>6000.0</td>
<td>667.0cGy</td>
<td>100.0</td>
</tr>
<tr>
<td>Unkien</td>
<td>0.16</td>
<td>0.0</td>
<td>5500.0</td>
<td>1.0cGy</td>
<td>100.0</td>
</tr>
<tr>
<td>OpticNerve_R</td>
<td>0.73</td>
<td>0.0</td>
<td>5500.0</td>
<td>0.0cGy</td>
<td>100.0</td>
</tr>
<tr>
<td>Lecrinal_R</td>
<td>0.72</td>
<td>0.0</td>
<td>5500.0</td>
<td>0.0cGy</td>
<td>100.0</td>
</tr>
<tr>
<td>Lecrinal_L</td>
<td>0.82</td>
<td>0.0</td>
<td>5500.0</td>
<td>0.0cGy</td>
<td>100.0</td>
</tr>
<tr>
<td>Eye_R</td>
<td>7.77</td>
<td>0.0</td>
<td>2600.0</td>
<td>0.0cGy</td>
<td>100.0</td>
</tr>
<tr>
<td>Lead DTV Statistics Template:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Capture 2 Screenshots

<table>
<thead>
<tr>
<th>Structure</th>
<th>Volume (cc)</th>
<th>Min Dose (cGy)</th>
<th>Max Dose (cGy)</th>
<th>Mean Dose (cGy)</th>
<th>Goal Type</th>
<th>Goal Volume (%)</th>
<th>Goal Volume (cc)</th>
<th>Goal Dose (cGy)</th>
<th>Actual</th>
<th>Winclusion</th>
</tr>
</thead>
<tbody>
<tr>
<td>GTV_R frontal</td>
<td>172.45</td>
<td>53.77</td>
<td>57.96</td>
<td>55.84</td>
<td>Min DTV Volume</td>
<td>100.00</td>
<td>172.45</td>
<td>5400.0</td>
<td>99.59%</td>
<td>173.09</td>
</tr>
<tr>
<td>PTV_R frontal</td>
<td>210.95</td>
<td>52.05</td>
<td>57.96</td>
<td>55.57</td>
<td>Min DTV Volume</td>
<td>95.00</td>
<td>210.95</td>
<td>5400.0</td>
<td>99.69%</td>
<td>211.05</td>
</tr>
<tr>
<td>BrainStem</td>
<td>25.67</td>
<td>0.00</td>
<td>66.73</td>
<td>1.0</td>
<td>Max Dose</td>
<td>6000.0</td>
<td>667.00</td>
<td>6000.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Chiasm</td>
<td>0.16</td>
<td>0.00</td>
<td>1.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>6000.0</td>
<td>1.00</td>
<td>6000.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>OpticNerve_R</td>
<td>0.78</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>0.00</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>OpticNerve_L</td>
<td>0.78</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>0.00</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Structure</th>
<th>Volume (cc)</th>
<th>Min Dose (cGy)</th>
<th>Max Dose (cGy)</th>
<th>Mean Dose (cGy)</th>
<th>Goal Type</th>
<th>Goal Dose (cc)</th>
<th>Goal Dose (cGy)</th>
<th>Goal Volume (cc)</th>
<th>Actual</th>
<th>Winclusion</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpticNerve_L</td>
<td>0.78</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>0.00</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Lateralis_R</td>
<td>0.77</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>0.00</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Lateralis_L</td>
<td>0.82</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>0.00</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Eye_R</td>
<td>7.77</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Eye_L</td>
<td>7.94</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Lens_R</td>
<td>0.22</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>1000.0</td>
<td>0.00</td>
<td>1000.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Lens_L</td>
<td>0.26</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>1000.0</td>
<td>0.00</td>
<td>1000.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Cochlea_R</td>
<td>0.09</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
<tr>
<td>Cochlea_L</td>
<td>0.12</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.00</td>
</tr>
</tbody>
</table>

Lead DTV Statistics Template: [ ] Save As Template

OK CANCEL
## Combine screenshots with Snagit

![Snagit interface](image)

**Steps:**
1. Capture relevant screenshots.
2. Use Snagit to combine and format the screenshots.
3. Paste the combined image into a PDF document.

---

**Table Example:**

<table>
<thead>
<tr>
<th>Structure</th>
<th>Volume (cc)</th>
<th>Min Dose (cGy)</th>
<th>Max Dose (cGy)</th>
<th>Mean Dose (cGy)</th>
<th>Goal Type</th>
<th>Goal Volume (%)</th>
<th>Goal Volume (cc)</th>
<th>Goal Dose (cGy)</th>
<th>Actual</th>
<th>% Inclusion</th>
</tr>
</thead>
<tbody>
<tr>
<td>UTV_R frontal</td>
<td>172.45</td>
<td>5327.0</td>
<td>5790.0</td>
<td>5548.0</td>
<td>Min DPH Volume</td>
<td>100.0</td>
<td>172.45</td>
<td>5400.0</td>
<td>99.99%/172.38cc</td>
<td>100.0</td>
</tr>
<tr>
<td>PTV_R frontal</td>
<td>230.03</td>
<td>5263.0</td>
<td>5790.0</td>
<td>5537.0</td>
<td>Min DPH Volume</td>
<td>95.0</td>
<td>226.19</td>
<td>5400.0</td>
<td>99.98%/227.03cc</td>
<td>100.0</td>
</tr>
<tr>
<td>Brainstem</td>
<td>26.47</td>
<td>0.0</td>
<td>557.0</td>
<td>1.0</td>
<td>Max Dose</td>
<td>6000.0</td>
<td>667.00</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Chiasm</td>
<td>0.16</td>
<td>0.0</td>
<td>1.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>OpticNerve_R</td>
<td>0.70</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>OpticNerve_L</td>
<td>0.72</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>5500.0</td>
<td>5500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Lacrimal_R</td>
<td>0.77</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>CRR Mean</td>
<td>2600.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Lacrimal_L</td>
<td>0.82</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>CRR Mean</td>
<td>2600.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Eye_R</td>
<td>7.77</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Eye_L</td>
<td>7.94</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Lens_R</td>
<td>0.20</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>1000.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Lens_L</td>
<td>0.16</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>1000.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Cochlea_R</td>
<td>0.00</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>Cochlea_L</td>
<td>0.12</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>Max Dose</td>
<td>4500.0</td>
<td>0.00</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
</tbody>
</table>

*MacLennan 2017*
Structured Reports
Using Structured Reports in MIM

- MIM has a template-based report generation system that uses the DICOM Structured Report
Click on Structured Reports
Choose your template

Select a Structured Reporting Template

- Empty Template
- AAMD Demo
  - Series: 1
  - Doses: 1
- Generic Dose Report
  - Series: 1
  - Doses: 1
  - Captures: 3
- PBS Robustness
  - Series: 1
  - Doses: 1

Manage Report Templates  OK  Cancel
Verify matching of data to slots

Series

<table>
<thead>
<tr>
<th>Series Name</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan CT</td>
<td>CT 307 Slices 2017-04-10 16:43:34 Prostate Visicols 1.25mm</td>
</tr>
</tbody>
</table>

Doses

<table>
<thead>
<tr>
<th>Series Name</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prostate7920</td>
<td>Prostate7920, ANON</td>
</tr>
</tbody>
</table>

Ensure all requirements are filled
Report is ready!
Easy two page DVH and scorecard
How is it done?

• Need to create a Clinical Goals template

• Need to create a Structured Report template
First set up some Clinical Goals
Create a Dose Constraint Set
Open up Structured Reports again
Choose “Empty Template” this time
Add two or three sections

- Patient Info
- Dose Constraints
- DVH
Almost ready
Add sections and configure

• Each module in MIM Structured Reports has its own configuration options

• Once everything looks the way you want it, save it as a Structured Report Template
WE NEED TO GO

DEEPER
Structured Reports used by SPTC

- Must test how different sources of uncertainty affect a PBS plan
  - **Imaging uncertainty**
    - Plus and Minus 3% stopping power
  - **Setup uncertainty**
    - 3mm shifts Ant, Post, Sup, Inf, Left, Right

- Calculate a new dose in all **8 test scenarios**

- Do we still get good coverage in each scenario?
Making a readable report

• SPTC’s solution was to export XiO doses to MIM

• Made a Structured Report Template that accepted all 9 doses

• Overlaid 2 test scenarios at a time over nominal plan

• 4 DVHs, 4 stat comparison tables
Example from robustness report

Original Plan (solid) vs 3mm ANT (heavy dashed) vs 3mm POST (thin dashed)
Changing gears a bit

• Not every script or template that improves documentation actually creates a document

• Next three sections will:
  – Create proof that potential collisions were evaluated
  – Validate the accuracy of text
  – Create a throwaway plan export cheat sheet
Air gaps and Collision Detection
First, some background

- For particle therapy (protons, electrons, etc) minimizing air gaps can be important.

- Devices such as cones, apertures, compensators, and range shifters have to be accurately modeled.

- 3D model can be rotated to look for problems.
All about our snouts

• SPTC has 4 interchangeable snout sizes:
  – 10 cm (round)
  – 18 cm (round)
  – 25 cm (round)
  – 40 cm (30x40 cm rectangle)

• Snouts can hold apertures and compensators, or range shifters
All about our snouts

• Snouts can be changed, but they are heavy
  – Need to call a 2-person IBA team to come with a lift cart

• Patient scheduling grouped by snout size
Planning limitations

- Have to use same snout for all beams even if suboptimal because of time to change snout
- Using a too-big snout could result in larger air gaps
- Planning systems don’t model the true geometry of the whole snout apparatus
The C2 app

• “C2” is a collision detection program written by Chang Chang (ProCure Proton Therapy Center, NJ)

• It models:
  – Range compensator
  – Knobs on front of snout
  – Metal housing

• Many other tools too
The snout is bigger than shown
Same beam modeled in C2
Change to left superior oblique
LSO still shows knob collision
After consulting with Physics...

WE’RE GONNA NEED

A SMALLER SNOUT
New snout design considerations

• Center is moving from Uniform Scanning to PBS

• PBS uses different beam modifying devices
  – Dose shaping is handled by spot placement

• Cyclotron beam energy range can treat 7.5 – 32.0 cm
  – Just need a simple cylinder of Lucite to pull range back either 4.0 cm or 7.5 cm for plans with shallow targets

MacLennan 2017
New snout design considerations

- Would be nice if new snouts could be changed by a therapist as easily as a photon wedge
  - Would make scheduling easier
  - Would allow multiple beams sizes in the same plan
The solution

• The 10, 18, and 25 cm snouts can all be replaced with a single adapter plate

• Interchangeable cones holding the appropriate-sized range shifter attach to the adapter plate

• The 40 snout will stay as it is
Adapter plate instead of snout
New cones with range shifters
Cones installed on adapter plate

- 10, 18, and 25 cm range shifters with cones
The collision detection problem

• RayStation’s mockup shows the usable diameter of the snout, not the true physical geometry

• With the new cone shape, C2 is no longer accurate

• We need a new solution
  – Preferably one that runs inside RayStation
How to draw snouts with scripts

• RayStation has a variety of contour scripting options

• Making **Spheres**, **Cylinders**, and **Boxes** is scriptable

• Just need to provide:
  – **Location** of the center of the shape
  – **Size** of the shape in each direction as applicable
  – For cylinders, must declare which **axis** it faces
Putting shapes together

• 10 cm, 18 cm, and 25 cm range shifters and cones are well-represented by two stacked cylinders

• Careful diameter and thickness measurements taken with help from Machinist Brad Ridgeway

• The 40 cm snout is more complex to draw
  – Boolean combination of 7 boxes and 3 cylinders
The 40 cm snout
Let’s try it out!

- **Left lateral** beam
  - Snout selection and position can be looked up in the RayStation plan data
  - Correctly-sized cylinders drawn in the appropriate location
  - Cylinders are oriented along the X-axis
Revisiting our left lateral
Overlaying the true size
Overlaying the true size
Change to Left Superior Oblique
Problem!

- We can’t draw a cylinder that isn’t on a cardinal axis
- We need to be able to draw at a cardinal angle and then rotate to match the actual plan angle
That’s gonna need some math

• RayStation has a rotation and translation tool for ROIs, but it requires a 4x4 matrix as input

• Physicist Jonathon Van Schelt to the rescue!
  – Pointed us to a website with the equations we needed
    • http://planning.cs.uiuc.edu/node102.html
    • http://planning.cs.uiuc.edu/node104.html
Some matrix math...

- **Yaw** (couch)

\[
\begin{bmatrix}
\cos(yaw) & 0 & \sin(yaw) \\
0 & 1 & 0 \\
-\sin(yaw) & 0 & \cos(yaw)
\end{bmatrix}
\]

- **Pitch** (n/a)

\[
\begin{bmatrix}
1 & 0 & 0 \\
0 & \cos(pitch) & -\sin(pitch) \\
0 & \sin(pitch) & \cos(pitch)
\end{bmatrix}
\]

- **Roll** (gantry)

\[
\begin{bmatrix}
\cos(roll) & -\sin(roll) & 0 \\
\sin(roll) & \cos(roll) & 0 \\
0 & 0 & 1
\end{bmatrix}
\]
Getting the angle right

• Need to decide on a point of rotation
  – (0, 0, 0) is easy

• Draw snout at appropriate snout-to-isocenter distance as though isocenter is at (0, 0, 0)

• Rotate snout shape around (0, 0, 0)

• Shift everything from (0, 0, 0) to true isocenter
What is the Matrix?

- To apply yaw, pitch, roll, **multiply in that order**

\[
\begin{bmatrix}
\cos(yaw) & 0 & \sin(yaw) \\
0 & 1 & 0 \\
-\sin(yaw) & 0 & \cos(yaw)
\end{bmatrix}
\begin{bmatrix}
1 & 0 & 0 \\
0 & \cos(pitch) & -\sin(pitch) \\
0 & \sin(pitch) & \cos(pitch)
\end{bmatrix}
\begin{bmatrix}
\cos(roll) & -\sin(roll) & 0 \\
\sin(roll) & \cos(roll) & 0 \\
0 & 0 & 1
\end{bmatrix}
\]

\[
\begin{bmatrix}
\cos(yaw) \cdot \cos(roll) + \sin(yaw) \cdot \sin(pitch) \cdot \sin(roll) & \sin(yaw) \cdot \sin(pitch) \cdot \cos(roll) - \cos(yaw) \cdot \sin(roll) & \sin(yaw) \cdot \cos(pitch) \\
\cos(pitch) \cdot \sin(roll) & \cos(pitch) \cdot \cos(roll) & -\sin(pitch) \\
\cos(yaw) \cdot \sin(pitch) \cdot \sin(roll) - \sin(yaw) \cdot \cos(roll) & \sin(yaw) \cdot \sin(roll) + \cos(yaw) \cdot \sin(pitch) \cdot \cos(roll) & \cos(yaw) \cdot \cos(pitch)
\end{bmatrix}
\]

- Add a row and column for post-rotation translation

\[
\begin{bmatrix}
\cos(yaw) \cdot \cos(roll) + \sin(yaw) \cdot \sin(pitch) \cdot \sin(roll) & \sin(yaw) \cdot \sin(pitch) \cdot \cos(roll) - \cos(yaw) \cdot \sin(roll) & \sin(yaw) \cdot \cos(pitch) & \text{translation}_x \\
\cos(pitch) \cdot \sin(roll) & \cos(pitch) \cdot \cos(roll) & -\sin(pitch) & \text{translation}_y \\
\cos(yaw) \cdot \sin(pitch) \cdot \sin(roll) - \sin(yaw) \cdot \cos(roll) & \sin(yaw) \cdot \sin(roll) + \cos(yaw) \cdot \sin(pitch) \cdot \cos(roll) & \cos(yaw) \cdot \cos(pitch) & \text{translation}_z \\
0 & 0 & 0 & 1
\end{bmatrix}
\]
Let’s try the LSO again
Now we know it clears
Next steps for collision checker

- Geometry is more or less sorted out

- Would be great to display:
  - Central axis air gap size
  - Distance of closest approach of shifter and cone
  - Color highlighting of areas intersecting or too close
Projects still in the design phase

- Beam name validation tool
- Mosaiq export helper tool
Beam Name Validation
Beam name validation

• SPTC beam name convention includes:
  – Gantry angle
  – Table angle
  – Beam angle abbreviation
  – Other suffixes as needed

• Example: “G90T0LL CD1”
  – Gantry 90
  – Table 0
  – Left Lateral
  – Cone Down 1
SPTC beam angle naming scheme

• 2 or 3 letter abbreviation denotes general direction
  – **Cardinal angle** name if at intersection of two planes
  – **Arc** name if on an arc in a single plane
  – **Octant** name if not on any plane

• Acronym built in this order:
  – Right or Left if applicable (\textbf{R} or \textbf{L})
  – Superior or Inferior if applicable (\textbf{S} or \textbf{I})
  – Anterior or Posterior if applicable (\textbf{A} or \textbf{P})
  – If any are not application, add Oblique to the end (\textbf{O})
Cardinal angle abbreviations

- **AP**: Anterior to Posterior
- **PA**: Posterior to Anterior
- **RL**: Right Lateral
- **LL**: Left Lateral
- **SUP**: Cranial vertex/zenith
- **INF**: Caudal nadir
Arc (in-plane, off-axis) abbreviations

- **RSO**: right superior oblique
- **RIO**: right inferior oblique
- **RAO**: right anterior oblique
- **RPO**: right posterior oblique
- **LSO**: left superior oblique
- **LIO**: left inferior oblique
- **LAO**: left anterior oblique
- **LPO**: left posterior oblique
- **SAO**: superior anterior oblique
- **SPO**: superior posterior oblique
- **IAO**: inferior anterior oblique
- **IPO**: inferior posterior oblique
Octant (out-of-plane) abbreviations

- **RSA**: right superior anterior
- **RSP**: right superior posterior
- **RIA**: right inferior anterior
- **RIP**: right inferior posterior
- **LSA**: left superior anterior
- **LSP**: left superior posterior
- **LIA**: left inferior anterior
- **LIP**: left inferior posterior
Validation approach

- Reconstruct what the name **ought to be** based on actual angles and patient orientation

- Compare generated name to the actual name

- Problem: No way to validate suffixes
  - Example: “G180T0PA Replan1”

- Solution: Only evaluate the first group of letters
Building the comparison string

- A string is a series of alphanumerical characters
- Start with just the letter “G”
- Add numeric gantry angle
- Add the letter “T”
- Add numeric table angle
- Now we need to figure out the angle label
What’s the angle label for G270T45?

...but patient is prone
What’s the angle label for G270T45?

Gantry
- \( G = 0 \)
- \( 0 < G < 90 \)
- \( G = 90 \)
- \( 90 < G < 180 \)
- \( G = 180 \)
- \( 180 < G < 270 \)
- \( G = 270 \)
- \( 270 < G < 360 \)

Table
- \( T = 270 \)
- \( 270 < T < 360 \)
- \( T = 360 \) (i.e. 0)
- \( 0 < T < 90 \)
- \( T = 90 \)

Position
- \( HFS \)
- \( FFS \)
- \( HFP \)
- \( FFP \)
- \( “LSO” \)
How big is this thing?

• This is going to be a BIG decision tree
  – 3 couch cardinal angles + 2 arcs between (5 options)
  – 4 gantry cardinal angles + 4 arcs between (8 options)
  – 4 patient orientations

• $5 \times 8 \times 4 = 160$ scenarios for 26 abbreviations

• **Forgot to mention** that Fixed Beam and IBL couch range is 0 to 180, not 90 to 270...
That’s ok

- We only have to set it up once
Putting it all together

• Once again, building the beam name:
  – Start with “G”
  – Add the numeric gantry angle
  – Add “T”
  – Add the numeric table angle
  – Add the angle label

• Now check if it matches the beginning of the beam name.
Mosaiq Helper
Entering RayStation info into Mosaiq

- Several key pieces of data either do not get automatically transferred to Mosaiq during export, or they must be manually verified for accuracy.
- Mismatch of coordinate system (z and y axes).
- Mosaiq only allows 1 decimal place in some fields.
Shifts (manual entry)

• Need to mentally flip direction
• Need to round to 1 decimal
• Need to notice the order is different

Position patient such that lasers line up with patient marks. Move the couch according to the PATIENT coordinate system:
- LEFT 2.43 cm (patient’s left).
- INFERIOR 2.28 cm.
- ANTERIOR 2.11 cm.
Isocenter (verification only)

- $X = X$, $Y = Z$, $-Z = Y$
Air Gap – What could go wrong?

- Position - shifter thickness - physical depth = Gap

\[ 19.15 - 6.5 - 7.94 = 4.71 \]
\[ \text{Round to 1 decimal: } 4.7 \]
A script would make this easy

- All of the data is readily available

- Just need to process the data and create either a popup window or PDF with a breakdown of everything that needs to go into Mosaiq

- Has someone else already done this?
That’s all for today!
Acknowledgements

• Alex Goughenour, CMD
• Jackie Castro, CMD
• Eric Cole, MS
• Brad Ridgeway
• Jonathon Van Schelt, PhD
• Charles Bloch, PhD
• Tony Wong, PhD
Questions?

MacLennan 2017